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Module 3, Lesson 1 
 

Running hot and cold 
 
In this activity, you will analyze monthly and annual temperature patterns in cities around the 
world. You will explore how latitude, elevation, and proximity to the ocean influence 
temperature patterns in the world’s tropical, temperate, and polar zones. 
 
Step 1: Open a map document 
 
1. Double-click the ArcMap icon on your computer’s desktop. 
 
2. When the ArcMap start-up dialog box appears, click Browse for more... 
 

        
 
 
 

3. Navigate to the Module 3 folder (OurWorld2\Mod3) and choose Global3.mxd (or 
Global3) from the list. 
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4. Click Open. When the map document opens, you see a world map. 
 

 
 
 
 
Step 2: Observe annual world temperature patterns 
 
The symbols on the map represent cities around the world. The color of each symbol 
reflects an average of temperatures recorded throughout the year in that city (in degrees 
Celsius). 

M3 
1. Look at the global temperature patterns displayed on the map. 

 
 

Answers to questions in this activity should be recorded on the answer sheet. 
 

 
 
Q1    Write three observations about the pattern of temperatures displayed on the 

map. Your observations should describe regions of the world, not specific 
countries or cities. 

 
2. Click the check mark next to the Average Yearly Temperature layer to turn it off. 
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Step 3: Label latitude zones 
 
1. Turn on the Latitude and Longitude layer. 

 
2. In the Table of Contents, right-click Latitude and Longitude and click Properties. Click 

the Labels tab. 
 

3. At the top of the Labels tab, click the check box next to “Label features in this layer.” 
Notice that NAME is already chosen as the field to use for labeling. 
 

4. In the Text Symbol section, use the drop-down menus to set the font to Arial and the 
size to 9. Set the style to Bold. 

 

 
 
5. Click OK. The major latitude and longitude lines are labeled on the map. 
 
 

In order to display the label for the prime meridian, you may need to zoom 
in or enlarge your map document window. 

 
 
For the purposes of this exercise, the areas between the major latitude lines represent five 
zones of latitude. The table below names each latitude zone and the area it covers. 
Zone Latitude range 

Zone Latitude range
North Polar Arctic Circle–North Pole
North Temperate Tropic of Cancer–Arctic Circle 
Tropical Tropic of Cancer–Tropic of Capricorn 
South Temperate Tropic of Capricorn–Antarctic Circle 
South Polar Antarctic Circle–South Pole

 
Now you will label each of these zones on your map. 
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6. On the Draw toolbar at the bottom of the ArcMap window, use the drop-down menus 
to set the font to Arial, the size to 9, and the style to Bold. 
 

 
 
 

If you don’t see the Draw toolbar, right-click in the gray area near the top 
of the ArcMap window and click Draw to turn it on. 

 
 

7. Click the Font Color drop-down menu and choose a deep violet color. 
 

 
 
8. Zoom in to the area between the Arctic Circle and the North Pole.  
 
9. On the Draw toolbar, click the New Text tool. The cursor turns into a plus sign with 

the letter A when you move it over the map. 
 

 
 

 
10. Click the map somewhere above the Arctic Circle. A text box appears. 

 
11. Type North Polar Zone in the box and press Enter. The North Polar Zone is now 

labeled in violet on the map. 
 

If you make a spelling mistake, double-click the text. Correct the mistake 
in the dialog box and click OK. 
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12. Label each of the remaining zones using the same procedure you used to label the 

North Polar Zone. Remember, the zones are the spaces between the lines of 
latitude. You may want to label the Tropical Zone twice, north and south of the 
equator. 
 

You can use the scroll bar to the right of the map display or the Pan tool to move up or 
down on your map. 
 
13. Click the Full Extent button to see the whole world. 

 
14. In the Table of Contents, right-click Latitude and Longitude and click Label Features 

to turn off the latitude and longitude (black) labels. Now you are left with the new 
latitude zones (violet) labels. 
 

You can toggle labels on and off by right-clicking a layer and clicking Label Features. A 
check mark on the menu next to Label Features indicates that labels are turned on. 

 
15. Click the Select Elements tool. Click any label on the map that you want to move, 

then click it again and drag it. Move the labels to the ocean area so that they cover 
very little of the continents. 
 

16. Turn on the Average Yearly Temperature layer. Observe the temperature patterns as 
they correspond to the latitude zones. 
 

17. Click the Identify tool. Click on any city dot. 
 

18. Click the “Identify from” drop-down menu and choose Average Yearly Temperature.  
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Q2    Use the Identify tool to click cities and get the necessary information to 

complete the table on your answer sheet (remember that each dot represents 
a city). 

 
Q3    Why do you think there aren’t any major cities in the North or South Polar 

Zones? 
 
Q4    How is the North Temperate Zone different from the South Temperate 

Zone? 
 

19. Turn off Average Yearly Temperature and close the Identify window. 
 
 

Step 4: Observe climate distribution 
 
1. Click the Add Data button. 

 
2. Navigate to the module 3 LayerFiles folder (OurWorld2\Mod3\Data\LayerFiles). 

Select Climate.lyr and click Add. 
 
The Climate layer displays the regions of the world characterized by different types of 
climate. 
 

Q5    Complete the table on your answer sheet. 
 
Q6    Which zone has the greatest number of climates? 

M3L1 
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3. Turn on the Average Yearly Temperature layer. 
 

Q7    Give an example of a city in each of the climate zones listed in the answer 
sheet (use the Identify tool to get the names of the cities). 

 
Q8    Ask your teacher if you should stop now and save your work. If so, ask for 

instructions on how to rename and save this map document. Record the new 
name of the map document and its new location on your answer sheet. Then 
from the File menu, click Exit. 

 
 
Step 5: Observe monthly temperature patterns in the Northern Hemisphere 
 
1. If necessary, start ArcMap and locate the map document where you saved it in Q8. 

Refer to your answer sheet for its name and location. Open the map document. 
 

2. In the Table of Contents, click the minus sign in front of the World Temperature 
Patterns data frame to collapse it. 
 

3. Click the plus sign in front of the World Cities data frame to expand it. Right-click 
World Cities and click Activate. 

 

 
 
You see a map centered on North America showing cities, rivers, and lakes. The symbol for 
Boston is highlighted on the map. If your map looks different than the one pictured above, 
use the Zoom In tool to drag a box around North America. 
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4. Click the View menu, point to Graphs, and click Monthly Temperature. 
 
The graph displays the monthly temperatures for Boston. You’re going to select additional 
cities on the map, but first you’ll reposition the graph and set the selectable layer to Cities. 

 
5. Click the graph’s title bar and drag it so that it doesn’t obstruct the map. 

 
6. At the top of the Table of Contents, click the List by Selection tab. Notice that one 

city (Boston) is selected. 
 

 
 

7. Click the Click to toggle selectable boxes for all layers except Cities to uncheck 
them. 

 

 
 
8. Click the List by Drawing Order tab to show the Table of Contents again. 

 
9. Click the Select Features tool. 

 
10. Click on Miami at the southern tip of Florida (if you are not sure which city is Miami, 

point to a city without clicking to display its name).  
 
Notice that both the map and the graph have changed.  
 

Q9    What does the graph show now? 
 
Q10   What city is highlighted on the map? 

 
11. Hold down the Shift key and select Boston again on the map. 

 
Q11   What does the graph show now? 
 
Q12   What city or cities are highlighted on the map? 
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Q13   Use the Monthly Temperature graph to compare Miami and Boston and 
complete the table on your answer sheet. 

 
12. Hold down the Shift key and click the city northeast of Boston. 
 

Q14   What is the name of the city?M3L1 
 

Q15    How does its monthly temperature pattern differ from Boston’s? 
 
13. Hold down the Shift key and click the closest city south of Miami. 
 

Q16   What is the name of the city? 
 
Q17   How does its monthly temperature pattern differ from Miami’s? 

 
14. Pause your cursor over a city symbol on the map to find that city’s coordinates. The 

coordinates (longitude followed by latitude) are displayed on the status bar at the 
bottom of the ArcMap window.  

 
 
 

The coordinates are displayed in decimal degrees rather than in degrees, minutes, and 
seconds. Latitudes north of the equator and longitudes east of the prime meridian are 
positive numbers, whereas latitudes south of the equator and longitudes west of the prime 
meridian are negative numbers. 
 

Q18    List the name of each of the cities displayed in the Monthly Temperature 
graph and complete the information in the table on the answer sheet. 

   
Q19    Based on the information displayed in the graph, the map, and the table in 

Q18, formulate a hypothesis about how the monthly temperature patterns 
change as latitude increases. 

 
 
Step 6: Test your hypothesis 
 
1. Click the Clear Selected Features button. 

 
2. The Monthly Temperature graph still shows the graphs you selected in Step 5 but will 

change when you make a new selection. 
 

3. Click the Pan tool. Click the map and pan over to Western Europe. 
 

4. Click the Find tool. The Find dialog box displays. 
 

5. Type Stockholm in the Find text box and click Find. A record (row) displays in the 
white box at the bottom of the dialog box. 
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6. Right-click the row and click Select. Stockholm is highlighted in blue on the map.  
 

7. Close the Find dialog box. 
 

8. Click the Select Features tool. Hold down the Shift key and select three more 
European cities that are increasingly south of Stockholm. The city names appear in 
the graph and the cities are highlighted on the map. 

 
To unselect a city that you selected by mistake, hold down the Shift key and 
click that city. To make the legend on the graph more readable, enlarge the 
graph window by dragging any of its borders. 

 
 

Q20    Complete the table on the answer sheet. 
 
Q21    Does the data for the cities you selected confirm or dispute your hypothesis in 

Q19? Explain. 
 
 
Step 7: Analyze temperature patterns in the Southern Hemisphere 
 
You’ve already formulated a hypothesis about how latitude affects monthly temperature 
patterns in the Northern Hemisphere. Now you will explore the effect of latitude on the 
monthly temperature patterns within the Southern Hemisphere. 
 
1. Clear the selected features. 

 
2. Click the Pan tool and reposition the map so that it is centered on Australia. 

 
3. Click the Select Features tool. Hold down the Shift key and click the three cities on 

Australia’s eastern and southern coasts. 
 

Q22    Complete the table on your answer sheet. 
 
Q23    Based on the information displayed on the graph, the map, and the table you 

just completed, compare the monthly temperature patterns in the Southern 
Hemisphere to those in the Northern Hemisphere. 

 
Q24    Formulate a hypothesis about the relationship between monthly temperature 

patterns and increases in latitude in the Southern Hemisphere. 

L1 
Step 8: Test your hypothesis for the Southern Hemisphere 
 
1. Clear the selected features. 
 
2. Click the Pan tool and reposition the map so that it is centered on and includes all of 

Africa (zoom in or out if you need to). 
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3. Use the Find tool to locate and select the city of Cape Town as you did for Stockholm 
above. 
 

4. Close the Find dialog box. 
 

5. Select two or three more African cities located between Cape Town and the equator. 
 

Q25    Complete the table on your answer sheet. 
 
Q26    Does the data for the cities you selected confirm or dispute your hypothesis 

about how latitude affects monthly temperature patterns in the Southern 
Hemisphere? Explain. 

 
6. Clear the selected features. 

 
7. Reposition your map so that it’s centered on North America. 
 
 
Step 9: Investigate the ocean’s influence on temperature 
 
In addition to latitude and hemisphere, a city’s proximity to the ocean also influences its 
temperature. Now you will investigate how the ocean influences the air temperature of 
coastal cities. 

 
1. Make sure that World Cities is the active data frame. 

 
2. One at a time, select all the cities in Canada. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Q27    In which Canadian city would you experience the coldest winter 
temperatures? 

 
Q28    In which Canadian city would you experience the warmest winter 

temperatures? 
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Q29    Looking at the map, why do you think the warmest city has winter 
temperatures that are so much warmer than the others? (Think of how this 
city is different from all the others in terms of its location.) 

 
3. Clear the selected features. 

 
4. Reposition your map so that it is centered on Western Europe. 

 
5. In the Table of Contents, right-click Cities and click Open Attribute Table. 

 
6. Click the top border for the Attributes of Cities table and move it down so that you 

can still see all of Western Europe on the map. 
 

7. Click the column heading NAME. The heading looks like a button that’s been pushed 
in, and the column is highlighted in blue. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Right-click the column heading and click Sort Ascending to make the list 

alphabetical. Scroll down the list to elect Amsterdam by clicking the small gray box in 
the first column of that row. The row that Amsterdam is in is highlighted in blue. 

1.  
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2.  
3.  
4.  
5.  
6.  
7.  
8.  
9.  
10.  
11.  
12.  
13.  
14.  

15. M3L1 
9. Scroll down the list. Hold down the Ctrl key and select the following cities, taking note 

of where each one is on the map as you select it: Berlin, Kiev, London, and Warsaw. 
 

10. All of the cities are highlighted in the table and on the map, and they are displayed 
on the graph. 
 

11. Minimize the table by clicking on the pushpin on the top right side of the table if it is 
necessary so that you can see the map and graph. Analyze the map and graph. 

 
 
 
 
 

Q30    Complete the table on your answer sheet. 
 
 
Q31    What do these cities have in common in terms of their locations on the earth? 
 
 
Q32    Which two cities have the mildest temperatures? 
 
 
Q33    What happens to the winter temperatures as you move from London to Kiev? 
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Q34    Why do you think some cities have milder temperatures than the others? 
 

 
Q35    Based on your observations for Canada (Q27–Q29) and Western Europe, 

formulate a hypothesis about the influence of proximity to the ocean (or 
distance from it) on patterns of temperature. 

 
 
Step 10: Investigate the impact of elevation on temperature patterns 
 
A city’s elevation significantly affects temperature in that city. You will now investigate the 
relationship between elevation and temperature. 
 
1. Click the Full extent button. 

 
2. Restore the Attributes of Cities Table tab under the Table of Contents if you 

minimized it. Click on the pushpin again to pin the table in place. 
 

3. Scroll up in the table until you find the city of Kisangani. Click the small gray box to 
the left of this record to select it. 
 

4. Scroll down in the table and, holding down the Ctrl key, select Libreville, Quito, and 
Singapore. Take note of where each one is on the map as you select it in the table 
(minimize the table if necessary so that you can see the map and the graph). 

 
Q36    Complete the table on your answer sheet. 
 
 
Q37    What do these cities have in common in terms of their locations on the earth? 
 
 
Q38    What temperature pattern do these four cities have in common? 
 
 
Q39    How is Quito different from the other three? 
 
 
Q40    Since all these cities are located on or very near the equator, what other 

factor could explain the difference in their temperature patterns? 
 
5. Restore the Attributes of Cities table if necessary. 

 
6. Click the Selected button at the bottom of the table. Only the selected records are 

displayed in the table. 
 

7. Right-click on the NAME column heading and click Freeze/Unfreeze Column. Scroll 
to the right until the ELEV_M (elevation in meters) field is showing. Drag your NAME 
column until it is adjacent to the ELEV_M field. 
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Q41    Analyze the selected records and complete the table on your answer sheet. 

 
8. Minimize the Attributes of Cities table. 

 
9. Compare the elevation table on your answer sheet to the graph on your computer. 

(Reopen your graph if necessary.) 
 

Q42    Based on your observation of temperatures along the equator and the 
information in the table in Q41, formulate a hypothesis about the influence of 
elevation on patterns of temperature. 

 
10. Clear selected features. 
 
 
Step 11: Revisit your initial ideas 
 
1. Take out the paper map you used at the beginning of the lesson to identify the three 

coldest cities in January and the three hottest cities in July. 
 

2. Restore the Attributes of Cities table and select the 13 cities that appear on your 
paper map. 
 

3. Click the Show selected records button on the bottom left of the table window. 
 

4. Scroll to the right until you see the NAME field. Drag it to the left until it is next to the 
column heading JAN_C (January temperature in Celsius). 
 

5. Click the JAN_C column heading to select it. The column is highlighted yellow. 
 

6. Right-click the JAN_C column heading and click Sort Ascending. The table is sorted 
from lowest (coldest) to highest (hottest) January temperatures. 
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Q43    On your answer sheet, rank the 13 cities from coldest to hottest according to 
their average January temperatures. 

 
7. Drag the NAME field to the right until it is next to the column heading JUL_C (July 

temperatures in Celsius). 
 

8. Right-click the JUL_C column heading and click Sort Descending. The table is sorted 
from highest to lowest July temperatures. 

 

 
 

Q44    Rank the 13 cities from hottest to coldest according to their average July 
temperatures. 

 
9. Compare your original predictions from your paper map with the correct answers on 

your answer sheet. 
 

Q45    Put a check mark next to the answers in Q43 and Q44 that you predicted 
correctly. 

 
10. At the bottom of the attribute table, click the Show all records button. 

 
11. Click the Clear Selected Features button at the top. 

 
12. Close the attribute table and the graph. (There are no cities selected on the map at 

this time.) 
 

13. Save your changes. 
 

14. Exit ArcMap by choosing Exit from the File menu. 
 
In this lesson you explored temperature data for 96 world cities. You explored the different 
latitude zones and have identified the variety of climates in each zone. You formulated and 
tested different hypotheses to explain temperature patterns. Now you know how latitude, 
hemisphere, proximity to the ocean, and elevation affect temperature patterns around the 
world. 


